Office 365

Working with Large Attachments

Point Solutions - Support  Gables One Suite 1100
UMIT Helpdesk  (305) 284-6565
Technical Support Email  itsupportcenter@miami.edu
## Handling Large Attachments Before Migration

### Handling Large Attachments (Outlook 2013/2016)
- Find Your Large Messages
- Permanently Deleting Messages
- Delete a message and its attachments, quick "I'm sure" version
- Delete a message and attachments after checking to be sure
- Delete a message's attachments but save the message
- Save some or all attachments, and then decide whether to save the message
- Move Large Messages to Local Storage

### Handling Large Attachments (Outlook 2011/2016 for Mac)
- Find Your Large Messages
- Permanently Delete Messages
- Delete a message and its attachments, quick "I'm sure" version
- Delete a message and attachments after checking to be sure
- Delete a message's attachments but save the message
- Save some or all attachments, and then decide whether to save the message
- Move Large Messages to Local Storage

### Handling Large Attachments (Apple Mail)
- Find Your Large Messages
- Numbered Steps for All Versions of Mac OS X
- Delete a message and its attachments
- Delete a message's attachments but save the message
- Save some or all attachments, and then decide whether to save the message
- Move Large Messages to Local Storage

### Handling Large Attachments (Outlook Web App)
- Decide how to handle each message

### Options For Very Large Mailings

### Alternatives
Handling Large Attachments before Migration

To prepare for the move to Microsoft's Office 365, individuals need to remove any messages in their mailbox that are larger than 25 MB. If your mailbox includes messages larger than 25 MB, you need to take some action on them. This includes both messages you've received and messages you've sent.

You should review these messages and decide, for each message, whether to

- save the attachments,
- delete the attachments but save the message,
- delete the message (including the attachments), or
- save the message to local storage.

In nearly all cases, these messages are large because of attached files. You may have already saved these files to disk when you received them. If there are oversized messages in your Sent or Sent Items folders, you probably still have the originals that you sent.

**What happens if you don't do anything?** When your mailbox is migrated to Office 365, any oversized messages that remain in your mailbox will be left behind.
Handling Large Attachments (Outlook 2013/2016)

Find Your Large Messages

If you already know where your large messages are, skip down to the section on deciding how to handle each message. Otherwise, follow the steps shown here to find your large messages.

1. From Outlook’s File tab, select Info (it may already be selected).
2. Click the large Cleanup Tools button, and then select Mailbox Cleanup. A Mailbox Cleanup dialog box will open.
3. Select **Find items larger than**, and, in the field next to it, enter 9999. (This is the largest value the field permits. It will find all messages larger than (about) 10 MB.)

4. Click **Find**. Depending on the total size of your mail store, you may have to wait a bit. A results dialog box will open, showing all the messages and their location.

5. In the results table, click **Size** (the column heading) to sort the list by message size.

6. The results table will include messages in your Deleted Items folder. That's okay for now, but when you finish reviewing the list, remember to empty your Deleted Items folder or permanently delete the large messages. See [Permanently Deleting Messages](#) for details.
Permanently Deleting Messages

In earlier steps you deleted one or more messages. In an effort to prevent accidental deletions, our email clients don't actually delete the messages immediately; instead the messages are moved to your Deleted Items folder. Now you need to permanently delete them.

The simple way is to empty the Deleted Items folder:
1. Right-click the Deleted Items folder (in the Navigation Pane), then select Empty Folder.
2. Click Yes to confirm permanent deletion.

A second way is to be more selective, and only permanently delete the large messages that can't be migrated to Office 365:
1. Select the Deleted Items folder in the Navigation Pane.
2. Click Size (the column heading) to sort the folder by message size.
3. Scroll to the end of the list with the largest messages.
4. Select the message(s) you want to delete.
5. Right-click, then select Delete.
6. Click Yes to confirm permanent deletion.
7. Repeat as necessary.

Now it's time to decide what to do with each message. For each, you can:
- Delete the message and its attachment(s).
- Delete the attachment(s) but save the message.
- Save some or all of the attachments, and then decide whether to save the message.
- Save the message to local storage.

Your goal is to end up with no messages larger than 25 MB.

When you delete a message (using any method listed here), you'll still see it in your list of big messages, but its location will have changed to "Deleted Items." Remember to empty your Deleted Items folder or permanently delete the large messages when you have finished reviewing your list. See Permanently Deleting Messages for details.
Delete a message and its attachments, quick "I'm sure" version

Right-click a message, then select **Delete** from the menu that appears.

When you delete a message (using any method listed here), you'll still see it in your list of big messages, but its location will have changed to "Deleted Items." Remember to empty your Deleted Items folder or permanently delete the large messages when you have finished reviewing your list. See [Permanently Deleting Messages](#) for details.

Delete a message and attachments after checking to be sure

1. Double-click a message. A normal Outlook message window will open. Here you can review the message text and the attachments.
2. To delete the message and attachments, click **Delete** in the Message ribbon.

When you delete a message (using any method listed here), you'll still see it in your list of big messages, but its location will have changed to "Deleted Items." Remember to empty your Deleted Items folder or permanently delete the large messages when you have finished reviewing your list. See [Permanently Deleting Messages](#) for details.
Delete a message's attachments but save the message

1. Double-click a message. A normal Outlook message window will open.
2. Click on an attachment. The Attachments Tools ribbon will appear. Depending on the attachment's file type; you may see a preview of the attachment.

3. Click **Remove Attachment**.
4. Repeat as desired for additional attachments.
5. Click the X in the upper-right corner of the message window to close it. When prompted, click **Yes** to save your changes to the message.
Save some or all attachments, and then decide whether to save the message

Saving an attachment does NOT remove it from the message; it only makes a separate copy of the attachment. When you have saved the attachments you want to keep, you must either (1) delete the message or (2) remove the attachments from the message, then save the now-smaller message.

1. Double-click a message. A normal Outlook message window will open.
2. Decide which attachments to save:
   a. To save one attachment:
      i. Click on the attachment's name.
      ii. Click Save As in the Attachment Tools ribbon.
      iii. Select the location to save to, then click Save.
      iv. Repeat as desired for other attachments.
b. To save all attachments:
   
   i. Click on any attachment's name.

   ii. Click **Save All Attachments** in the **Attachment Tools** ribbon.

   iii. Click **OK** in the small **Save All Attachments** dialog box.

   iv. Select the location to save to and then click **OK**.

3. Decide whether to save or delete the message:
   
   - To save the message, follow the steps in the **Delete a message's attachments but save the message** section above.
   - To delete the message, click the **Message** tab in the ribbon, then click **Delete**.
Move Large Messages to Local Storage

If you do not already have an Outlook data file (PST) on your computer where you can store these messages, follow these steps:

1. Click the ribbon's **Home** tab.
2. Click **New Items**, then **More Items**, then **Outlook Data File**. A Create or Open Outlook Data File dialog box will open.
3. Make sure the selected location is the **Outlook Files** folder in **My Documents**.
4. Enter a name for this new file, such as “Large Messages.”
5. Click OK. You should now see your new file at the bottom of the Mail section of the Navigation Pane.

6. Select the message(s) you wish to save.
7. Right-click the selected message(s), select Move, then select Other Folder. A small Move Items dialog box will open.
8. Select the local location where you want to store the messages (if you created a PST file in step 1, select that file here), then click OK.
9. Repeat as necessary.
Handling Large Attachments (Outlook 2011/2016 for Mac)

Find Your Large Messages

If you already know where your large messages are, skip down to the section on deciding how to handle each message. Otherwise, follow the steps shown here to find your large messages.

1. Click in the Search box. This will make the Search tab appear.

2. On the Search tab, click All Mail
3. On the Search tab, click Attachment, then Greater than 10 MB. Just above the display of messages, you'll see a line that reads Size Is Greater Than 10000. (Even though you're interested in messages greater than 25 MB, Outlook's largest search choice is 10 MB.)

4. Click the plus sign to the right of Size Is Greater Than 10000. A second row of search criteria will appear just below it.

5. Click Item Contains, and then select Account from the list that appears. You may need to scroll down.
6. Click **None**, and then select the name of your Exchange account. It may be the only item in the list (other than "None").

7. From the **View** menu, select **Columns**, then make sure both **Size** and **Folder** are checked.

8. Click **Size** (the column heading) to sort by size. Scroll to the end of the list with the largest size.

The results table will include messages in your Deleted Items folder. That's okay for now, but when you finish reviewing the list, remember to empty your Deleted Items folder or permanently delete the large messages. See **Permanently Deleting Messages** for details.
Permanently Delete Messages

In earlier steps you deleted one or more messages. In an effort to prevent accidental deletions, our email clients don't actually delete the messages immediately; instead the messages are moved to your Deleted Items folder. Now you need to permanently delete them.

The simple way is to empty the Deleted Items folder:

1. Right-click (or ctrl-click) the Deleted Items folder (in the Navigation Pane), then select Empty Folder.
2. Click Yes to confirm permanent deletion.

A second way is to be more selective, and only permanently delete the large messages that can't be migrated to Office 365:

1. Select the Deleted Items folder in the Navigation Pane.
2. If you do not see a Size column, from the View menu, select Columns, then Size.
3. Click Size (the column heading) to sort the folder by message size.
4. Scroll to the end of the list with the largest messages.
5. Select the message(s) you want to delete.
6. Right-click (or ctrl-click), then select Delete.
7. Click Delete to confirm permanent deletion.
8. Repeat as necessary.

Now it's time to decide what to do with each message. For each, you can:

- Delete the message and its attachment(s).
- Delete the attachment(s) but save the message.
- Save some or all of the attachments, and then decide whether to save the message.
- Save the message to local storage.

Your goal is to end up with no messages larger than 25 MB.

When you delete a message (using any method listed here), you'll still see it in your list of big messages, but its location will have changed to "Deleted Items." Remember to empty your Deleted Items folder or permanently delete the large messages. See Permanently Deleting Messages for details.
Delete a message and its attachments, quick "I'm sure" version

Right-click (or ctrl-click) a message, then select **Delete** from the menu that appears.

When you delete a message (using any method listed here), you'll still see it in your list of big messages, but its location will have changed to "Deleted Items." Remember to empty your Deleted Items folder or permanently delete the large messages. See [Permanently Deleting Messages](#) for details.
Delete a message and attachments after checking to be sure

1. Double-click a message. A normal Outlook message window will open. Here you can review the message text and the attachments.

2. To delete the message and attachments, click **Delete** in the Message ribbon.

When you delete a message (using any method listed here), you'll still see it in your list of big messages, but its location will have changed to "Deleted Items." Remember to empty your Deleted Items folder or permanently delete the large messages. See [Permanently Deleting Messages](#) for details.
Delete a message's attachments but save the message

1. Double-click a message. A normal Outlook message window will open.

2. Right-click (or ctrl-click) on an attachment, then select **Remove** from the menu that appears. You'll need to confirm that you want to remove the attachment.

3. Repeat as desired for additional attachments.

4. Close the message window.
Save some or all attachments, and then decide whether to save the message

In earlier steps you deleted one or more messages. In an effort to prevent accidental deletions, our email clients don’t actually delete the messages immediately; instead the messages are moved to your Deleted Items folder. Now you need to permanently delete them. The simple way is to empty the Deleted Items folder:

Saving an attachment does NOT remove it from the message; it only makes a separate copy of the attachment. When you have saved the attachments you want to keep, you must either (1) delete the message or (2) remove the attachments from the message, then save the now-smaller message.

1. Double-click a message. A normal Outlook message window will open.
2. Decide which attachments to save:
   - To save one attachment:
     i. Right-click (or ctrl-click) on the attachment's name.
     ii. Select Save As from the menu that appears.
     iii. Select the location to save to, then click Save.
     iv. Repeat as desired for other attachments.
   - To save all attachments:
     i. Right-click (or ctrl-click) on any attachment's name.
     ii. Click Save All from the menu that appears.
     iii. Select the location to save to, and then click Choose.
3. Decide whether to save or delete the message:
   - To save the message, follow the steps in the Delete a message’s attachments but save the message section above.
   - To delete the message, click Delete in the Message ribbon.
Move Large Messages to Local Storage

1. If you do not see On My Computer in the list of mailboxes in the Mail section of the Navigation Pane (if it's there, you'll find it inside your Inbox), follow these lettered steps:
   a. From Outlook's Outlook menu, select Preferences.
   b. Click General.
   c. Uncheck Hide On My Computer folders.
   d. Close the General dialog box.
   e. If you do not already have a mailbox where you want to save the large messages in On My Computer, follow these lettered steps:
   f. Right-click On My Computer in the list of mailboxes, then select New Folder. A new, untitled folder will be created.
   g. Enter a name for this new mailbox, for example Large Messages.

2. Select the message(s) you wish to save.
3. Right-click the selected message(s). Select Move, then Choose Folder. A Search dialog box will open.
4. Type the beginning of the name of your target mailbox, Large Messages in this example. As you type, folders that match your search will be displayed.
5. Once your destination mailbox is visible, select it, then click Move.
6. Repeat as necessary. When repeating, in step 4, after selecting Move, you will see your folder listed. Click it rather than repeating your search.
Handling Large Attachments (Apple Mail)

Find Your Large Messages

If you already know where your large messages are, skip down to the section on deciding how to handle each message. Otherwise, follow the steps shown here to find your large messages.

If you are using Apple Mail 5 (which comes with Mac OS X 10.7, Lion) or Apple Mail 6 (which comes with Mac OS X 10.8, Mountain Lion), begin by following the lettered steps immediately below, and then continue with the numbered steps.

If you are using Apple Mail 4 (which comes with Mac OS X 10.6, Snow Leopard), SKIP the lettered steps, and go directly to the numbered steps below.

Numbered Steps for All Versions of Mac OS X

1. From the Mailbox menu, select New Smart Mailbox.
   - What is a Smart Mailbox?
     Smart Mailbox displays messages that are stored in other mailboxes, based on the criteria you define. A Smart Mailbox is a virtual location, that is, messages displayed there are not actually moved from their current location.

2. In the dialog box that opens, name it “All Mail.”
3. Click Any Recipient, and then select Date Received from the list that appears.
4. Click is today, then select is before the date from the list that appears.
5. Click on each part of the date, and then use the arrows or type to enter today's date (any date after July 15, 2012 will work).
6. Click to put a check next to Include messages from Sent.
7. Click **OK**. You'll see a new folder called All Mail listed under Smart Mailboxes. Depending on the total number of messages you have, it may take a while (up to a few minutes) before it is fully populated.

8. Make sure the All Mail folder is selected.

9. From the **View** menu, select **Columns**, then make sure there are checks next to **Size** and **Mailbox**.

10. Click **Size** (the column heading in the display of messages) to sort the mailbox by message size.

11. Scroll to the end with the largest messages.

Now it's time to decide what to do with each message. For each, you can:

- **Delete the message and its attachment(s).**
- **Delete the attachment(s) but save the message.**
- **Save some or all of the attachments, and then decide whether to save the message.**
- **Save the message to local storage.**

Your goal is to end up with no messages larger than 25 MB.

---

**Delete a message and its attachments**

1. Click on a message to select it.
2. Confirm whether you need the message in the preview pane, or by opening the message (double-click) and closing it once you’ve checked.
3. **Press Command-X (Apple-X) on your keyboard or, from the Edit menu, select Cut.**

---

**Delete a message's attachments but save the message**

There is no UNDO for this method. All attachments are deleted with one command.

1. Double-click a message. A normal Mail message window will open.
2. From the **Message** menu, select **Remove Attachments**.
3. Close the message window.
Save some or all attachments, and then decide whether to save
the message

Saving an attachment does NOT remove it from the message; it only makes a separate copy of
the attachment. When you have saved the attachments you want to keep, you must either (1)
delete the message or (2) remove the attachments from the message, then save the now-
smaller message.

1. Double-click a message. A normal Mail message window will open.
   If you do not see the names of the attachments, click the gray arrow just below
   the To line of the message header.
2. Decide which attachments to save:
• To save one attachment:

   1. Right-click (or ctrl-click) on the attachment's name.
   2. Select **Save to Downloads Folder**.
   3. Repeat as desired for other attachments.

• To save all attachments:

   Click **Save**. All the attachments for this message will be saved to your **Downloads** folder.
3. Decide whether to save or delete the message:

- To save the message, follow the steps in the Delete a message's attachments but save the message section above.
- To delete the message, click Delete in the toolbar.

Move Large Messages to Local Storage

1. If you do not already have an appropriate folder on your Mac, follow these lettered steps:
   a. From Mail's Mailbox menu, select New Mailbox.
   b. For Location, select On My Mac.
   c. Give your mailbox a name such as Large Messages.
   d. Click OK.
2. Select the large message(s) you wish to save.
3. Right-click (or ctrl-click) a selected message, then select Move To. Under On My Mac, select the mailbox you wish to save to.
4. Repeat as necessary.

Do not use the Archive feature in Lion or Mountain Lion, as it leaves the messages on the server.
Handling Large Attachments (Outlook Web App)

The procedure described below to find large messages needs to be performed on each folder individually, where, with other email clients; you are able to search globally.

1. Sign into your account in Outlook Web App.
2. Make sure your Inbox is selected in the folder hierarchy on the left.
3. Under the Search box, click Arrange by and select Size. Your messages will be sorted into size categories, with Enormous (>5 MB) being the largest.
4. Next to Arrange by Size, if you see Smallest on top, click those words; it will change to Largest on top.
5. Scroll to the top of the mailbox.

Once you've decided what to do with each of your large messages, you'll need to repeat this procedure for every folder in your account.

Decide how to handle each message

For each message 25 MB or larger, decide whether to save the attachments. To save an attachment, click on its name while viewing the message. Follow your browser's method of saving a file to your hard drive.

Then, to delete a message from the list of messages in a folder, click to highlight it, then click Delete in the toolbar just above the Search box. Or, if the message is open in its own window, click the X in the toolbar.
Options for Very Large Mailings

Office 365 includes some security defenses that limit the ability of an individual to send huge numbers of messages in a short amount of time. If you have legitimate large mailings to do, please understand these limits and the alternatives you have for delivering your messages.

- The maximum number of addresses allowed in the To:, Cc:, and Bcc: fields is 500 per message.
- The maximum number of messages that can be sent from your email client is 30 per minute.
- The maximum number of recipients that can receive messages sent from your account (or an Exchange Group Account) in a 24-hour period is 10,000.

Notes:

- It doesn't matter whether the recipients are at the University or elsewhere.
- The 24-hour period is a rolling window: for example, if you send messages to 2,000 recipients at 8:30 am, then messages to 5,000 recipients at 12 noon, then messages to 2,000 recipients at 2:30 pm, and messages to 1,000 recipients at 4 pm, you won't be able to send any more messages until 8:30 am the next day.
- If you try to send a message after exceeding the limit, you will either see an immediate error about the recipient limit, or the message will be returned to you with an error. Save the message to your Drafts folder and try again later.
- A message will only be delivered if it can be delivered to all the recipients without going over the 10,000-limit. For example, if you've already sent messages to 9,900 recipients, and you attempt to send one message to 150 recipients, it will not be delivered because it would be 50 recipients over your limit for the 24-hour period.
- See Microsoft's detailed explanation of message and recipient limits.

Alternatives

Create and use one or more listservs -- a good choice if you'll email these same individuals many times and they're not all at the University